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I. Introduction 
 
A) Purpose: 

 
The main purpose of this write-up is to describe data collection and data 
processing used to create maps that can help predict whether New Orleans will be 
underwater by 2100 and by how much. In order to tackle this problem, this project 
takes into account three major factors contributing to the potential submergence 
of New Orleans. These factors include subsidence, sea-level rise, and erosion. 
 

B) Problem Formulation: 
 
Background 
 
Continuing relief efforts for the damage caused by Hurricane Katrina in 2005 
have increased debate over the long-term sustainability of New Orleans and other 
low-lying coastal areas of Louisiana. Certainly, flooding is not an uncommon 
problem in this city sitting in a bowl near the Louisiana coast [Fig. 1]. New 
Orleans actually rests at an average of two meters (six feet) below sea level. The 
city is basically surrounded by water: Lake Pontchartrain to the north (B), the 
great Mississippi River to the south (A), and wetlands to the east leading out to 
Lake Borgne.  
 

 
 

Figure  1  
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Natural levees offer some protection to an area lying below sea level, but in an 
attempt to increase this protection, humans have created an extensive man-made 
levee system around New Orleans. While this may generally increase their flood 
control, it has disrupted a natural river system in which sediment would dump out 
over the area after a flood. As a result, not enough material is being deposited to 
make up for sinking due to subsidence. The city of New Orleans also pumps 
water out of the area to help keep it dry, which may intensify the effects of 
subsidence, causing the city to sink faster than it normally would.  
 
Also, as demonstrated by the disaster of Hurricane Katrina in 2005, the levees 
only offer so much protection against flooding. In this case, the storm surge 
caused by the hurricane stressed the levees to the point of failure. The result of 
this breach was major flooding. According to CBS News and New Orleans Mayor 
Ray Nagin, 80 percent of the city was under water in August 2005 when Katrina 
and levee breaches flooded the city. 
 
In addition, the growing concern of sea-level rise associated with climate change 
has worsened the long-term outlook for the city. Increasing temperatures could 
cause sea-level to rise by: “expanding ocean water, melting mountain glaciers and 
small ice caps, [and] causing portions of the coastal section of the Greenland and 
Antarctic ice sheets to melt or slide into the ocean” (Environmental Protection 
Agency). The Intergovernmental Panel on Climate Change (IPCC) estimates that 
the global average sea level will rise by 18-59 cm by 2100. In such a low-lying 
and low-relief city like New Orleans, even the small mean value of this estimate, 
39 cm, would not go entirely unnoticed, especially in conjunction with the effect 
of subsidence. 
 
A combination of coastal erosion (by wave processes, storm action, etc.), the 
effects of subsidence, and a rising sea-level spells trouble for New Orleans. What 
is the future for this city? 
 
According to US environment correspondent Suzanne Goldenberg: 
 
A  vast  swath  of  the  coastal  lands  around  New  Orleans  will  be  underwater  by  the  

dawn  of  the  next  century  because  the  rate  of  sediment  deposit  in  the  Mississippi  

delta  can  not  keep  up  with  rising  sea  levels,  according  to  a  study  published  

today.  

  

Between  10,000  and  13,500  square  kilometres  of  coastal  lands  will  drown  due  to  
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rising  sea  levels  and  subsidence  by  2100,  a  far  greater  loss  than  previous  

estimates.  

 
[From the article: Climate change: Rising sea level to submerge Louisiana 
coastline by 2100, study warns] Found online at: 
http://www.guardian.co.uk/environment/2009/jun/29/rising-sea-level-new-orleans 
 
The Problem 
 
Will New Orleans be submerged by 2100, and by how much?  
 
To determine whether this may be true, spatial and tabular data will be collected 
for the purpose of research and data manipulation using GIS software. These can 
then be presented as a map from which measurements can be taken to answer the 
question. The major factors contributing to potential submersion of New Orleans 
by 2100 included: subsidence, rise in sea-level, and coastal erosion.  
 
In determining the effect of subsidence, data for soil types will be examined and 
ranked based on physical properties of the soil, consideration for the weight of 
buildings resting on top of the soil, and compared with previously measured 
subsidence rates for the area. The measured subsidence rates for the area may take 
in to account additional causes, such as pumping water from the soil. This project 
will not directly utilize pumping information for the Orleans Parish. A range of 
subsidence rates can then be assigned to these ranked soil groups. 
 
As sea-level rise is also a rate, for the sake of simplicity, it will be combined with 
the subsidence rates. This rate for sea-level rise can be added on top of the rates 
for subsidence. The rate of sea-level rise from the year 2000 to 2100, a rate of ~ 
40 cm/100 years is pulled from the mean value of the estimate from the IPCC, 
presented in the Background section above. Then, the combined values for 100 
years of subsidence and sea-level rise can be subtracted from an elevation raster. 
 
In considering coastal erosion, data for shoreline loss from 1932 to 1990 will be 
examined in the Digital Data Series DDS-79, Coastal Erosion and Wetland 
Change in Louisiana by the U.S. Geological Survey (USGS). Several transect 
measurements across the shoreline loss can be averaged to come up with a rough 
estimate of average coastal erosion. Then, this value will be plugged in as a buffer 
to subtract from land in contact with water to show an estimated loss of land. 
 

 

http://www.guardian.co.uk/environment/2009/jun/29/rising-sea-level-new-orleans
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II. Data Collection  
 
Data were collected from several online sources: 
 
1. City of New Orleans Geographic Information Systems (CNOGIS) Portal site 

by The One New Orleans Community Recovery & Resources 
http://gisweb.cityofno.com/cnogis/dataportal.aspx  
 

a) Parish Boundary  
– data download and html metadata  
(last update to website 12/23/2006) 

b) Streets  
– data download and html metadata  
(last updated to website 02/29/2008) 
 

2. The 2008 Louisiana Spatial Data Index (LSDX) 
by The Louisiana Geographic Information Center (LAGIC) 
http://lagic.lsu.edu/geodata/downloads/LSDX_2008.pdf 
 

a) Levees in Louisiana 
- data download: levees_usace_2006.zip 

b) State Maintained Highways in Louisiana 
- data download: state_highways_ldotd_2007.zip 

c) Louisiana Land and Water Interface 
- data download: landwater_interface_losco_1992.zip 

d) NOAA Coastal Change Analysis Program (C-CAP) Land Cover and 
Change Data 
- data download: landcover_la_noaa_2005.zip 

e) Landsat Thematic Mapper Satellite Image 2005 
- data download: landsat5tm_la_lsu_2005.zip 
 

3. Atlas: The Louisiana Statewide GIS 
http://atlas.lsu.edu/rasterdown.htm 
 

a) LIDAR Data  
– DEM for every ¼ quad (by USGS) within or overlapping the area of 
Orleans Parish [31 total – see section A1 in the Procedure for a 
complete list] 
 

http://gisweb.cityofno.com/cnogis/dataportal.aspx
http://lagic.lsu.edu/geodata/downloads/LSDX_2008.pdf
http://atlas.lsu.edu/rasterdown.htm
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4. Soil Data Mart 
Natural Resources Conservation Service (NRCS) 
http://soildatamart.nrcs.usda.gov/ 
 

a) Soil data and metadata for Survey Area Symbol: LA071 with Survey 
Area Name: Orleans Parish, Louisiana 
– tabular and spatial data download (received as an export file via 
email, after submitting a request for information), spatial format: 
ArcView Shapefile, coordinate system: UTM Zone 15 Northern 
Hemisphere (NAD 83), MS Access Version: Access 2002, Template 
DB Version: 33.1, Template DB Name: soildb_US_2002, size: 1.7M 
– report on Physical Soil Properties for all soil map units, PDF format 
 

5. Digital Data Series DDS-79, Coastal Erosion and Wetland Change in Louisiana  
by the U.S. Geological Survey (USGS) 
http://pubs.usgs.gov/dds/dds79/HTMLDOCS/catalog.htm 
 

a) la_morphology_cewc (USGS Open-File Report 00-417)  
– metadata and files 

b) la_process_loss_cewc (USGS Open-File Report 00-418) 
- metadata and files 
 

III. Procedure 
 
The procedure followed involves the following general steps: 
 
1. Creating an elevation raster from LIDAR data 
2. Creating a ranked soil raster using reclassify, taking into account subsidence and  
    sea-level rise 
3. Subtracting rasters to create a new raster, showing the combined effects of  
    subsidence and sea-level rise on elevation 
4. Using the buffer tool to show the effect of erosion 
5. Creating a binary raster to show land below sea-level, and comparing this for the  
     year 2000 and the year 2100  

A)  Creating an Elevation Raster from LIDAR Data 
 
This section greatly mirrored the process outlined in the PDF “Working With Elevation 
Data,” URPL 969 – Applied GIS Workshop: Rethinking New Orleans After Hurricane 
Katrina, Spring 2006. This pdf may be found online at: 
http://coastal.lic.wisc.edu/urpl969-katrina/urpl969-spring06-lab-elevation-data-
roughdraft-10Feb06.pdf 

http://soildatamart.nrcs.usda.gov/
http://pubs.usgs.gov/dds/dds79/HTMLDOCS/catalog.htm
http://pubs.usgs.gov/dds/dds79/HTMLDOCS/Browsefiles/la_process_change_cewc.htm
http://coastal.lic.wisc.edu/urpl969-katrina/urpl969-spring06-lab-elevation-data-roughdraft-10Feb06.pdf
http://coastal.lic.wisc.edu/urpl969-katrina/urpl969-spring06-lab-elevation-data-roughdraft-10Feb06.pdf
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1. LIDAR data was downloaded from the Atlas LIDAR Downloader at 

http://atlas.lsu.edu/lidar. After selecting Orleans Parish, which is outlined in green 
when the cursor hovers over New Orleans on the map, the map zoomed into the 
area of interest. Clicking on ¼ quads pulled up available downloads for each. For 
this project, DEM data was downloaded for each ¼ quad of interest. After 
prompted with the File Download box, I navigated to an appropriate area to create 
a new folder titled no_lidar in which to save the files. 
 
DEM data was downloaded for all of the following areas, which are within or 
overlap the area of Orleans Parish: 
 
a) NEW ORLEANS WEST NW ¼, SW ¼, NE ¼, and SE ¼ Quads 
b) SPANISH FORT SW ¼ and SE ¼ Quads 
c) NEW ORLEANS EAST NW ¼, SW ¼, NE ¼, and SE ¼ Quads 
d) SOUTH POINT SE ¼ Quad 
e) LITTLE WOODS NW ¼, SW ¼, NE ¼, and SE ¼ Quads 
f) CHALMETTE NW ¼, SW ¼, NE ¼, and SE ¼ Quads 
g) BELLE CHASE NE ¼ Quad 
h) NORTH SHORE SW ¼ and SE ¼ Quads 
i) CHEF MENTEUR NW ¼, SW ¼, NE ¼, and SE ¼ Quads 
j) RIGOLETS SW ¼ and SE ¼ Quads 
k) ALLIGATOR POINT NW ¼, SW ¼, and NE ¼ Quads 

 
Unfortunately, the MARTELLO CASTLE NE ¼ Quad is unavailable, and was 
not found elsewhere online. So, this small piece of information is missing for 
Orleans Parish. 
 
StuffIt (or WinZip) was used to extract the compressed files in the .zip files. 
 
After opening ArcMap, all of the DEM data were loaded to a new map.When 
asked if you would like to create pyramids, I selected No. 
 
To make sure no DEM information needed for the Orleans Parish was missing, 
the outline for Orleans Parish was also loaded (Parish_boundary.shp), and then 
symbolized as hollow with a bright orange outline so it was easy to see on top of 
the DEM data [Fig. 2]. All of the DEM information for land areas within Orleans 
Parish filled the outline. Missing areas included the area represented by 
MARTELLO CASTLE NE ¼ Quad and any area that would only be water. 

http://atlas.lsu.edu/lidar
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2. The “DEM to Raster” tool was used to convert the LIDAR files into the GRID 
format. This is located in ArcToolbox > Conversion Tools > To Raster > DEM to 
Raster.  
 
In the DEM to Raster box, the following choices were made [Fig. 3]: 
Input USGS Dem file: dem_2908901ne.dem 
Output raster: c_ne 
Output data type: INTEGER 
 
For convenience, the output raster was saved directly to the no_lidar folder. 
 

 
 
 

Figure  2  

Figure  3  
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Output raster names were based on abbreviations of the “quad name_¼ corner” 
(for example c_ne is for CHALMETTE NE ¼ Quad, where CHALMETTE = c 
and NE ¼ = ne). 
 
This process of converting DEM to raster was repeated for all DEM data. 
 

3. Then, the LIDAR files were merged using the “Mosaic to New Raster” tool. This 
is located in ArcToolbox > Data Management Tools > Raster > Raster Dataset > 
Mosaic to New Raster. 
 
In the Mosaic to New Raster box, all of the LIDAR rasters were loaded as Input 
Rasters, the no_lidar folder was chosen as the Output Location, and lidar_msc 
was typed in as the Raster dataset name with extension. Just to be safe, no_east_se 
was imported as the Coordinate system for the raster, which should be 
NAD_1983_UTM_Zone_15N [Fig. 4] 
 

 
 
 
Note: There was a glitch of some sort that kept skewing the first two rasters I 
loaded in the list for the mosaic, while all others connected nicely. Therefore, I 
used no_west_sw and no_west_nw (the NEW ORLEANS WEST SW ¼ and NW 
¼ Quads) as extra data for the program to mess up with the glitch, because those 
areas will not be included in the study area. Therefore, they were loaded first. 

Figure  4  
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It won’t matter that they are tilted, as they will be clipped out later. Note that they 
are tilted in figure 5. They are located within the red rectangle with an arrow 
pointing to it. 
 

 
 

4. Lidar_msc was then loaded in ArcMap. I took a moment to check its Source 
information in Layer Properties, including Raster Information, Extent, Spatial 
Reference, and Statistics.  
 
Then, the raster was symbolized. Using Classify, the Classify Method was set to 
Defined Interval with an Interval Size of 1. The color ramp chosen to represent 
the data is Elevation #1. 
 

5. The lidar raster is then clipped to the Orleans Parish boundary to remove 
information outside of this area. 
 
Spatial Analysis should be turned on, along with its extension. Options needed to 
be set. This is found on the Spatial Analysis drop down menu. An appropriate 
Working directory was chosen, and the Analysis mask was set to 
Parish_boundary. The analysis mask is the layer the lidar raster will clip to. 
Analysis Coordinate System was set to the second option so it will be the same as 
the active data frame [Fig 6]. 

 
  

Figure  5  
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Extent was set to Same as Layer “Parish_boundary” and Cell size was set to Same 
as Layer “lidar_msc” 
 
The Raster Calculator was when used to clip to lidar_msc raster to the 
Parish_boundary. This was done by loading lidar_msc in Raster Calculator, then 
clicking “Evaluate”.  
 

6. Reclassify was used to fill in the blank no data areas for the raster within the 
parish boundary.  
 
First, the Calculation should be symbolized in the Symbology tab under 
Properties. Using Classify, the Classify Method was set to Defined Interval with 
an Interval Size of 1. 
 
Then, from the Spatial Analysis drop-down menu, the Reclassify box was brought 
up and filled in accordingly. All new values should be filled in as -28, -27, etc. 
The new value for New Data was set to -1. [This was decided on the basis that the 
water area representing Lake Pontchartrain has a pixel value of -1, and the 
majority of the no data represents the rest of Lake Pontchartrain within the 
Orleans Parish boundary.] The option to Change missing values to no data should 
be selected and the Output raster set to save as lidar_rc in the no_lidar folder [Fig. 
7]. 
 
The result should look similar to figure 8. 
 
 

Figure  6  



Elizabeth  A.  Bloch      New  Orleans,  Louisiana  in  2100:  

      Effects  of  Subsidence,  Sea-­‐Level  Rise,  and  Erosion  

Page  |  11    

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

B)  Creating a Ranked Soil Raster Using Reclassify,  
      Taking into Account Subsidence and Sea-level Rise 
 

1. Soil data was loaded into the map as the soilmu_a_la071.shp file. In the 
Symbology tab under Properties, all values for Value Field musym were added in 

Figure  7  

Figure  8  
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Categories, Unique values. Then, <all other values> was deselected. Random was 
left as the color ramp selection. 
 

2. To get started on determining a ranking system for subsidence rates, I examined a 
report on “Exploration of Subsidence and Elevation in Orleans Parish” by Prof. 
David Hart of the University of Wisconsin-Madison, which explores the 
relationship between subsidence and other factors such as geology, the location of 
pumping stations, land use, soil types, water wells, levees, and roads. This article 
can be found online at: http://coastal.lic.wisc.edu/urpl969-katrina/urpl969-group2-
paper-03May06.pdf. The section on Subsidence and Soil Type was especially 
helpful. 
 
From the information give in the report, I decided to rank the following soils by 
subsidence rate (on a ranking system where 7 = highest rate, 1 = lowest rate, and 
0 = water): 
 
Preliminary Ranking 
Urban land (Ub) = 6 
Allemands (Ae) = 5 
Aquents (An, AT) = 5 
Westwego Series (Ww) = 4 
Harahan Series (Ha) = 3 
Sharkey Series (Sk, Sh) = 2 
Commerce/Cancienne Series (Cm, Co, CS) = 1 
Water = 0 
 
To guesstimate the ranks for the remaining soils, I mirrored decisions made in this 
report with information provided by the report on Physical Properties of the soils 
downloaded from the Soil Data Mart [See Appendix A]. In general, I decided that 
soils with high percent of organic matter would have higher subsidence rates than 
soils with high percent of clay. I also considered whether the soil was mostly 
covered by buildings, as the overlying weight of these would increase its 
subsidence rate. I then considered the general pattern for the other soils. 
 
I determined that (GE) and (Dp) should have subsidence rates similar to (Ha), 
(CE) should be similar to (Ww), (LF) and (LV) should be similar with the (Ae, 
An, and AT) group. (Ke) seemed to fall somewhere between (Ww) and the (Ae, 
An, and AT) group. The new basic ranking was then the following: 
 
New Basic Ranking 
Urban land (Ub) = 7 
Allemands (Ae) = 6 
Aquents (An, AT) = 6 
Arents and Aquents (LV) = 6 
Lafitte (LF) = 6 
Kenner (Ke) = 5 

http://coastal.lic.wisc.edu/urpl969-katrina/urpl969-group2-paper-03May06.pdf
http://coastal.lic.wisc.edu/urpl969-katrina/urpl969-group2-paper-03May06.pdf
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Westwego Series (Ww) = 4 
Clovelly (CE) = 4 
Harahan Series (Ha) = 3 
Gentilly (GE) = 3 
Dump (Dp) = 3 
Sharkey Series (Sk, Sh) = 2 
Commerce/Cancienne Series (Cm, Co, CS) = 1 
Water = 0 
 
However, numbers representing subsidence rates need to be assigned to this 
ranking system. The relationship between this basic ranking system and 
subsidence rates was based on the information in the “Exploration of Subsidence 
and Elevation in Orleans Parish” report. (Ub) has the highest subsidence rate at -
1.9 ft per 50 years. For the purpose of this project, feet was converted into meters, 
and the value then multiplied by 2 for a value of about 1.2 m per 100 years. I 
broke down the 0 to 1.2 range into sections to assign to the ranked soil groups. 
 
I then decided to convert this into centimeters to make calculations using Raster 
Calculator easier later on, because it doesn’t handle decimal places well. 
 
Final Ranking 
Urban land (Ub) = 120 
Allemands (Ae) = 100 
Aquents (An, AT) = 100 
Arents and Aquents (LV) = 100 
Lafitte (LF) = 100 
Kenner (Ke) = 80 
Westwego Series (Ww) = 70 
Clovelly (CE) = 70 
Harahan Series (Ha) = 50 
Gentilly (GE) = 50 
Dump (Dp) = 50 
Sharkey Series (Sk, Sh) = 30 
Commerce/Cancienne Series (Cm, Co, CS) = 20 
Water = 0 
 

3. Soil data was then reclassified with this ranking system. 
 
In order to reclassify, the soil shapefile must be converted to a raster. This is done 
through the Spatial Analysis drop-down menu option Convert > Features to 
Raster. 
 
In the Fatures to Raster box, the following choices were made [Fig. 9]: 
Input features: soilmu_a_la071 
Field: musym 
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Output cell size: 5 
Output raster: soil_rstr saved to an appropriate location 
 
 
 
 
 
 
 
 
 
 
 
 
 
The cell size must be set to 5 because the lidar raster has a cell size of 5. This is 
important because the cell size for rasters must be the same in order to perform 
calculations in Raster Calculator, which will be used later in the project. 
 
Now the soil data can be reclassified. 
 
In the Reclassify box, the Input raster was set to soil_rstr and the Reclass field 
was set to MUSYM. The New values should be filled in according to the Final 
Ranking (section B2). I decided the value for NoData should be set equal to that 
of water (W), so NoData = 0. The option to Change missing values to NoData 
was also selected. The Output raster was saved to an appropriate location as 
soil_rc2 [Fig. 10]. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure  9  
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Figure  11  

Figure  10  
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4. Sea-level rise is also a rate, so I decided I should add the effect of sea-level rise to 
this same raster because I can just subtract the combined elevation changes due to 
subsidence and rising sea-level from the lidar raster when I make calculations 
using Raster Calculator. 
 
To do this, a rate of 40 cm per 100 years was simply added on top of the values in 
the Final Ranking. The soil_rc2 raster was reclassified, now using the combined 
subsidence and sea-level rise values (40, 60, 70, 90, 110, 120, 140, 160). The new 
reclassified subsidence/sea-level raster was saved as soil_rc3. 
 

C)  Subtracting Rasters to Create a New Raster,  
      Showing the Combined Effects of Subsidence and Sea-level Rise on Elevation 
 

1. The soil raster is now in centimeters, but the lidar raster is still in meters. 
Therefore, the lidar raster must also be converted into centimeters. 
 
This can actually be done using the Raster Calculator. 
 
In Raster Calculator, lidar_rc was loaded, then multiplied by 100. This equation 
had the form [lidar_rc]  * 100.  
 
Then, the raster Calculation was symbolized. Using Classify, the Classify Method 
was set to Defined Interval with an Interval Size of 100. The color ramp chosen to 
represent the data is Elevation #1. 
 

2. To show the combined effects of subsidence and sea-level rise on elevation, the 
soil raster was subtracted from the lidar raster in Raster Calculator. This equation 
had the form [Calculation] – [soil_rc3]. 
 
Then, the raster Calculation2 was symbolized. Using Classify, the Classify 
Method was set to Defined Interval with an Interval Size of 100. The color ramp 
chosen to represent the data is Elevation #1. 
 

3. With Calculation2 above Calculation, Calculation2 was hidden and unhidden to 
get an idea of the difference between the two. I noticed that the marsh areas to the 
northeast seemed to blend in more with Lake Pontchartrain after the change. 
Compare figures 12 and 13. 
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Elevation before effects of subsidence and sea-level rise 
 

 
Elevation after effects of subsidence and sea-level rise 

Figure  12  

Figure  13  
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D)  Using the Buffer Tool to Show the Effect of Erosion 
 
 

1. Data pertaining to erosion was loaded to ArcMap and symbolized. 
 
This included the la_process_change_cewc.shp file and the 
landwater_interface_LOSCO_1992.shp file 
 
The landwater_interface was symbolized with Value field = CLASS under the 
Categories > Unique Values in the Symbology tab of Properties. All values for 
CLASS were added, which only includes Land and Water. Land was symbolized 
with a light tan, and water was symbolized with the Lake option in Symbol 
Selector. <all other values> was deselected. 
 
The la_process_change was symbolized Value field = CLASS under the 
Categories > Unique Values in the Symbology tab of Properties. All values for 
CLASS were added, which should include Direct Removal, Erosion, Land, and 
submergence. I accepted the default random colors. <all other values> was 
deselected. 
 

2. The la_process_change was more closely examined in order to determine a rough 
average erosion value along the coast. 
 
After zooming into a coastal area at a scale of 1:20,000, the measure tool was 
used to measure transects across the erosion along the coast [Fig. 14]. I measured 
20 different transects from various coastal areas around Orleans Parish. The 
average was found to be about 120 meters. Metadata for the layer notes that this 
erosion is from 1932 to 1990, which is a difference of 58 years. By combining 
this information, I obtained a rate of 120 meters per 58 years. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure  14  
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This project is interested in the year 2100 in comparison with the 
landwater_interface, which is information from 1992. So, 1992 was subtracted 
from 2100 for a difference of 108 years. By setting 120m/58yrs = x/108yrs, x was 
solved and found to equal about 223 m. So, by the year 2100, 223 meters will be 
eroded away from the land. This will be done later using the buffer tool, but first 
layers for land and water need to be set up. 
 

3. The water and land were selected by attributes and made into two separate layers. 
 
This was done by Select by Attributes from (Selection > Select by Attributes).  
 
The following choices were made [Fig. 15]: 
Layer: landwater_interface_LOSCO_1992 
Method: Create a new selection 
The following equation was built: “CLASS” = ‘Land’ 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After selecting Land, the layer was right clicked and Data > Export Data. . . was 
selected to bring up the Export Data box. Selected features were exported as a 
new shapefile named land_1. This was added to the map as a new layer. 
 

Figure  15  



Elizabeth  A.  Bloch      New  Orleans,  Louisiana  in  2100:  

      Effects  of  Subsidence,  Sea-­‐Level  Rise,  and  Erosion  

Page  |  20    

  

This process was repeated for ‘Water’ and saved as a new shapefile named 
water_1. 
 

4. To show the elevation information bounded by land around the year 2000, the 
calculation for elevation was sandwiched between water_1 and land_1, which 
represent the land-water interface at that time. To show only land area from our 
original lidar calculation (named Calculation), water_1 was placed above 
Calculation and land_1 was placed below Calculation. The land can be 
symbolized with a light tan, and the water can be symbolized with Lake from the 
Symbol Selector. The result should look similar to Figure 16. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Then, the buffer tool was used to show the effect of erosion, which is a difference 
of 223 meters from the year 2000 to 2100. The buffer tool is located in 
ArcToolbox > Analysis Tools > Proximity > Buffer.  
 
To show the effect of erosion on the land, the following choices were made in the 
Buffer box [Figure 17]: 
Input Features: land_1 
Output Feature Class was named land_2 
Linear unit: -223 Meters 
Side Type: FULL 
Dissolve Type: ALL 
 
 
 

Figure  16  
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This buffer process was mirrored for water, except that the Linear unit should be 
set to 223 Meters (as a positive value). The Output Feature Class was named 
water_2. 
 
(The buffering for the water was taking too long, so I made a side step to reduce 
the amount of information being processed. I did this by creating a new shapefile 
(which I named water_box), drawing a large rectangle around the area of interest 
with the editor to create a new polygon, and then setting it as the analysis mask in 
spatial analysis so I could clip water_1 to this new polygon. This involved 
converting features to a raster for the clipping, and then converting it back into 
features in order to perform the buffer.) 
 
To show the elevation information bounded by land around the year 2100, the 
second calculation for elevation (Calculation2) was sandwiched between water_2 
and land_2, which represent the land-water interface at that time. This step 
mirrored step 4 above. The result should look similar to Figure 18. 

Figure  17  
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E)  Creating a Binary Raster to Show Land Below Sea-Level,  
      and Comparing This for the Year 2000 and the Year 2100 
 

1. To show what parts of the land are below sea level, binary rasters were computed 
from the lidar Calculation (representing elevation for the year 2000) and from 
lidar Calculation2 (representing elevation for the year 2100). 
 
This was done by producing a Conditional Statement in the Raster Calculator. 
The statement used was con([grid] < = 0,1), where [grid] is Calculation. The 
water areas for the new raster (named Calculation3) were then symbolized with a 
blue and the display was set as 50% transparent, in order to show the elevation 
information below. The result should look similar to figure 19. 
 
This process was repeated for Calculation2. The result should look similar to 
figure 20. 
 

Figure  18  
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Area below sea-level in 2000, represented by the transparent  
blue area (Calculation3) over the elevation raster (Calculation) 
 

 
Area below sea-level in 2100, represented by the transparent 
blue area (Calculation4) over the elevation raster (Calculation2) 
 
 
 
 
 
 
 
 

Figure  19  

Figure  20  
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IV. Discussion 
 

A) What percent of land in New Orleans is already below sea-level in 2000? 
 
I clipped the land_1 (the land in 2000) to the Orleans Parish boundary, named it 
land_12, then found its area using 3D Analyst. This was done by setting the Layer for 
3D Analyst to land_12, then selecting Surface Analysis > Area and Volume… from 
the 3D Analyst drop-down menu. The Input surface was set to land_12, and the 
“Calculate statistics” button was pressed to find area. The 2D area of land_12 was 
found to be 416417900 m2 [Fig. 21]. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Then, I clipped Calculation3 (the land below sea-level in 2000) to a polygon version 
of land_12 (which I named land_12b). The result was Calculation5. The 2D area of 
Calculation5 was found to be 206469600 m2. 
 

Figure  21  
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Calculation5, shown in light blue, resting on top of  land_12, shown in brown 
 
To find the percent of land in New Orleans already below sea-level in 2000, I divided 
the area of Calculation5 by land_12, and multiplied by 100.  
 
The percent of land in New Orleans is already below sea-level in 2000 is 49.6%. 
 

B)  What percent of land in New Orleans may be below sea-level by 2100? 
 
I attempted to follow the same process in determining areas for 2100. However, for 
unknown reasons, the land_2 (the land in 2100) failed to clip to the Parish boundary, 
as it would not allow for conversion from features to raster. 
 
While I was unable to determine an actual percentage, I visually compared areas to 
determine an increase in the area below sea-level in 2100 from 2000. Most of the area 
that went below sea-level between 2000 and 2100 was the wetlands are to the east 
and northeast of Orleans Parish. A reasonable value for the percent of land in New 
Orleans that may be below sea-level by 2100 might be about 70%  
 

C) What is the overall change in elevation due to subsidence and sea-level rise from 
2000 to 2100 in Orleans Parish? 
 

Figure  22  
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In 2000, the maximum elevation was at 5900 cm (59 m) and the minimum elevation 
was at -2800 cm (-28 m). In 2100, the maximum elevation was at 5810 cm (58.10 m) 
and the minimum elevation was at -2870 cm (-28.7 m). The change in minimum 
elevation from 2000 to 2100 was -70 cm, and the change in maximum elevation was  
-90cm. 
 
Within the Orleans Parish, sections changed elevation within a range of -40 cm to  
-160 cm from the year 2000 to 2100. 
 

V. Conclusion 
 
New Orleans, although currently below sea-level by up to a value of -28 meters, is 
kept dry by protection from levees and removal of water by pumping. Despite this 
added protection, flooding is still a serious concern because the city is so low-lying 
and has such low-relief. 
 
However, the man-made levees may actually harm New Orleans in the long-term 
because it disrupts a natural system in which flooding would drop out sediment to 
help replace that lost due to subsidence. In addition, the rate of subsidence is 
increased by of the weight of the overlying city compressing the sediments below. 
Subsidence rates are also increased by the extraction of water from the soil, 
effectively decreasing its volume, which would cause it to sink even more. The 
overall effect is that the ground beneath the City of New Orleans is slowly sinking. 
This may occur at up to a rate of -1.2 cm per year, which would cause an overall 
change of 120 cm (1.2m) from 2000 to 2100. 
 
In addition, sea-level is on the rise, and low-lying coastal areas, such as New Orleans, 
are at a great risk. As water rises, the coastal land will begin to flood and be subjected 
to increasing erosion rates. Storms and wave-action are quickly eroding the shoreline 
of Louisiana, decreasing the land area. This can be clearly seen in comparison of 
figure 16 and figure 18. The area at greatest risk for flooding and erosion is the 
wetlands in the east and northeast of Orleans Parish.  
 
If there was complete failure of the levee system, the current New Orleans would 
surely face some serious flooding problems. Up to 49.6% of the land in Orleans 
Parish is already below sea-level. With a storm surge from a major hurricane, such as 
Katrina, it is possible that up to about 80% of the city could become flooded. In some 
areas, flooding may even reach 28 meters. On average, flooding would be about 2 
meters. 
 
It is estimated that 70% of New Orleans may be below sea-level by 2100. If a similar 
situation created by Hurricane Katrina were to occur in 2100, it is likely that at least 
90% of Orleans Parish would be underwater. In some areas, flooding could even 
reach 28.7 meters. On average, flooding would be about 2.5 to 4 meters. 
 


